Mac OS 8 is here

Faster, more efficient, friendlier, and more capable than any Macintosh system yet, Mac OS 8 is the most important release of the Macintosh operating system since 1984.

What's the big deal? The most visible is a dramatic new look and feel that incorporates a range of new ways to display, find and use files. The biggest power enhancement is that the Finder is now fully PowerPC native and is 'multi-tasking' so it can do several things at once. Internet access is tightly integrated to the OS so you can work with it more easily. Windows compatibility is better than ever. Java software can now run directly from your desktop.

The bottom line is you'll be able to get more done in less time.

**More PowerPC native code**

The whole system is faster and more responsive on Power Macintosh computers (though it also works well on 68040 based machines). It's also more reliable and stable.

**Multi-tasking Finder - pat your head and rub your stomach at the same time**

Multi-tasking is the technical term for being able to manage several tasks simultaneously. In practical terms, this means that once you start any finder operation like copying a file or formatting a disk, you can get on and do something else. No more staring at hands moving around a watch face, spinning balls or filling bar graphs. Just set it going then get on with what you're doing while the Finder keeps working.

**The new look**

In fact, Mac OS 8 gives you a range of new looks. Apart from cosmetics like background pictures and a choice of fonts for the Finder, this gives you a lot more control over what appears in folder windows and how it's presented.

continued on page 2
Welcome again!

Hi everyone,

As we finalise this issue of AppleNews, we’re rushing around getting ready for the launch of Mac OS 8 (just a week away). We’ve been using Mac OS 8 on our machines here at Apple and had plenty of demos. And we’re still finding clever little refinements Apple’s OS designers have sneakied in. There’s no doubt this is a major revision. We’ve very quickly reviewed its features here in AppleNews, but do get in to your Apple reseller or visit our web site to put it through its paces. We’re confident you’ll notice a real increase in productivity and stability.

Over the page you’ll find details of our new big-end and home computers. Including the fastest home PC, the Power Macintosh 6500/300. And topping that for speed the Power Macintosh 9600. With a 300 or 350MHz PowerPC 604e chip and ultrafast 100MHz inline cache memory, these new top models are redefining 'fast' in a personal computer.

We often get asked about Apple merchandise – t-shirts, caps etc. While it’s not quite ready to launch yet, soon you’ll be able to get all sorts of ways to 'show your true colours'.

Gil Amelio has moved on. He leaves the company in a much better condition than when he joined us 18 months ago: with A$1.6 billion in the bank, inventory and quality problems sorted out and a tighter range of first class products. Best of all, this belt-tightening has been done without skimping on new product development.

Our thanks to you, our users, for your loyalty to us. We’re doing our best to make sure we deserve it.

Lorraine Foster
Editor

Internet access that’s an integral part of the system

Mac OS 8 includes a range of Internet software: Netscape Navigator, Microsoft Internet Explorer, Claris Emailer Lite and Internet Setup Assistant to make set up and connection a breeze. The personal web server lets you publish anything you want on the Internet or on a corporate intranet – directly from your desktop.

We’ve also included PointCast Network and Castanet Tuner to get information delivered to you automatically.

Multimedia that sets the standard – again

QuickTime, QuickTime VR (virtual reality), QuickDraw 3D and MPEG are all part of the system.

Superior support for DOS and Windows files

Mac OS 8 lets you use floppy disks, CDs and removable disks created on Windows machines as easily as you use Mac ones. Files created by most common Windows applications can be opened and automatically converted to Macintosh applications using MacLinkPlus, which is a standard part of the Mac OS.

Java support is built in

Java software will now run directly from the desktop, so Java applications aren’t limited to use in your web browser.

10 reasons to upgrade to Mac OS 8

1 New multitasking Finder lets you copy large files while you launch applications or open documents.

2 The Internet Setup Assistant helps you get online in minutes.

3 Pop-up windows keep files handy.

4 Publish a personal web site in just a few easy steps.

5 View, open and edit Windows files within the Mac OS.

6 Multimedia, including virtual reality scenes, 3-D graphics, full-screen video, digital music, and more.

7 Connect to, explore and publish on the web, using your choice of popular browsers.

8 Install your favourite photo or graphic as your desktop picture.

9 The new installer and Mac OS Setup Assistant install and configure Mac OS 8 quickly and easily.

10 Run Java software directly from your desktop rather than through a web browser.
Your desktop will never be the same again

QuickTime Media Layer makes multimedia an integral part of the system

Pop this menu up any time to do common operations on files, folders and applications

The multitasking finder lets you get back to work while it’s busy

Built-in e-mail keeps you in touch

Will it run on my Mac?

Mac OS 8 runs on Macintosh models with 68040 or PowerPC processors (except for 68030 systems with PowerPC upgrade cards). You’ll need at least 12MB of RAM, with virtual memory set to at least 20MB. The new System needs at least 65MB of hard disk space, but up to 150MB if you install all the optional items.

How do I get it?

Upgrades are available from authorised Apple resellers for $149 (with a $50 rebate if you have Mac OS 7.6)

If you’ve bought a new Macintosh since June 1, you can upgrade for just $19.95.

Contact Claris upgrades on 1 800 028 316.

Special offer to AppleNews readers

Order the Mac OS 8 upgrade from Apple Software upgrades, and we’ll send you the November Apple software updates CD (which will include the Mac OS 8.0.1 update release) free.

Phone us on 1300 300 561 to order.

Where does Rhapsody fit in all this?

Now that Rhapsody has been announced as Apple’s next operating system (due for release in about a year), there are some people confused about the future of the Mac OS. Here’s the story.

Rhapsody is not a replacement for the Mac OS. Apple will be supporting both operating systems for a long time to come.

Why two operating systems?

The key reason is that it’s simply impossible to give all our users everything they need in a single OS. So our two operating systems will be clearly focussed on each group’s needs; Rhapsody aimed at the high-end users who really need its high powered features (and have the hardware to run it effectively). These include full memory protection, full multi-tasking and support for symmetric multiprocessing.

The Mac OS will continue to develop, providing plenty of easy-to-use power for the majority of home, small business and education users. Rhapsody will be compatible with both Mac OS applications and new ‘Yellow Box’ Rhapsody applications. So it will be a smooth and simple transition for current Mac OS users who need Rhapsody’s power. Their current applications will continue to run alongside new ones designed specifically for Rhapsody.

Snippets

QuickTime 3.0 wins NAB award

QuickTime 3.0, the latest release of Apple’s industry-standard digital media system software won the ‘Pick of Show’ Award for the advancement of the art and science of television broadcast at the recent National Association of Broadcasters (NAB) show, in Las Vegas, Nevada.

NSW and SA schools win

Early this year, Apple was one of two computer suppliers chosen by the NSW Department of School Education to provide computers for the state’s public schools. Schools could choose a Macintosh or Windows machine. More than half chose Macintosh. It was a similar story in South Australia, where Apple was one of only two computer manufacturers chosen to supply the state’s school computers.

PowerPC vs Intel MMX

The new ‘MMX’ Intel chips are supposed to be the ant’s pants for multimedia. Sorry, not when they’re compared with Macintosh computers using PowerPC processors, at least according to MacUser magazine who put three computers through a battery of tests.

A 200MHz Power Macintosh 9500 won the vast majority of their tests against not only a 200MHz Pentium MMX, but Intel’s latest generation 266MHz Pentium II. And our latest models now run at up to 350MHz so it’s going to be a long time before they catch up.

To read the details visit:
http://www4.zdnet.com/macuser/mu_0797/features/mmx.html

High speed ‘net connection with Telstra cable

Telstra recently launched its new Big Pond broadband cable service, making really high speed Internet access practical for Mac users with access to Telstra’s cable (the same cable that provides Foxtel in Sydney and Melbourne).

Access is as much as 100 times faster, and because you’re permanently connected to the ‘net, there are no dialing delays. You need a 68040 or Power Macintosh, a special cable modem (which Telstra sells) and an Ethernet connection.

Visit Telstra’s Web site for details:
http://www.bigpond.net/bpcable/index.htm
Power Macintosh speeds are up – again!

The last couple of years have seen dramatic increases in the speed of processor chips. And Power Macintosh is staying well in front – now with processors running at up to 350MHz.

Our latest Power Macintosh 8600 and 9600 series are based on the easy-access tower design we introduced earlier this year. But now the 8600 comes with a 250MHz PowerPC 604e processor. And the 9600 has either a 300MHz or 350MHz chip.

The 8600, aimed at multimedia production, has a video input and a Zip drive as standard. The 9600 includes an accelerated video card with 8MB VRAM for full 24-bit colour on displays up to 1,600 by 1,200 pixels.

<table>
<thead>
<tr>
<th></th>
<th>8600/250</th>
<th>9600/300</th>
<th>9600/350</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>250MHz 604e</td>
<td>300MHz 604e</td>
<td>350MHz 604e</td>
</tr>
<tr>
<td>Memory</td>
<td>32MB</td>
<td>32MB</td>
<td>64MB</td>
</tr>
<tr>
<td>Hard disk</td>
<td>4GB Fast SCSI</td>
<td>4GB Fast SCSI</td>
<td>4GB Fast SCSI</td>
</tr>
<tr>
<td>Display support</td>
<td>2MB VRAM, exp. to 4MB</td>
<td>Accelerated PCI video card with 8MB VRAM</td>
<td></td>
</tr>
<tr>
<td>Other features</td>
<td>Three PCI expansion slots</td>
<td>Five available PCI expansion slots</td>
<td></td>
</tr>
<tr>
<td>Rec retail price</td>
<td>$6,495*</td>
<td>$7,795*</td>
<td>$9,795*</td>
</tr>
</tbody>
</table>

All have 1MB of high speed (100MHz) in-line level 2 cache memory – effectively doubling the transfer rate between the processor and cache, 24X CD-ROM drive, Ethernet, internal & external SCSI buses. Prices are for CPU, keyboard and mouse. Displays shown are not included.

Power Macintosh 5500 – powerful, stylish computing

Apple's all-in-one computers have come a long way from the original Macintosh. Our latest, the stylish Power Macintosh 5500/250, has a 250MHz PowerPC 603e processor, 32MB of memory, a 4GB hard disk drive, 15 inch multiple scan display, 2D and 3D graphics acceleration, 12x CD-ROM drive, video-in and stereo speakers. Whew!

And it comes complete with a full range of software – ClarisWorks, the Apple Internet Connection Kit and an array of utilities, reference, education and entertainment packages. Everything you need for home or small business computing. The package costs $3,950* or $3,995 with a TV Tuner.
Big, colourful and precise – the AppleVision 850 Display

For publishers, multimedia authors, photographers – Apple’s new AppleVision 850 Display is ideal for anyone who needs a large and very accurate colour display.

Built around a 20 inch Sony Trinitron tube (482mm diagonal viewing area), maximum resolution is 1,600 by 1,200 pixels (it can be switched to other resolutions at any time).

Apple’s DigitalColor technology is built-in to guarantee high colour accuracy. This patented calibration system adjusts colour over time. And because it supports ColorSync, you can accurately match on-screen colours to printers and scanners. The display’s white point can also be set to simulate different lighting conditions.

The unit complies with a full range of energy and magnetic field emission standards and works with both Mac OS and Windows 95 systems.

The price is $3,400*.

* Please read this: All the prices quoted here are the Australian recommended retail prices when we went to press. Computer prices do not include displays except for the Power Macintosh 5500. All prices, specifications and system configurations can change. Please contact your authorized Apple location or visit our web site for up to date prices, specs and configurations. http://www.apple.com.au

Power Macintosh 6500 – compact towers of power

The 6500/300 provides very high performance from its 300MHz 603e chip. The 6500/275 Video Editing System has a 275MHz 603e plus Avid Cinema video hardware and software to edit your videos, add transitions, titles and special effects.

Both can display 24-bit colour on monitors up to 17 inches and feature a built-in subwoofer. CD-ROM drive is built-in.

For expansion, there are two PCI slots (one is used by the Avid card in the Video Editing model). The 6500/300 with 64MB RAM and 4GB hard disk costs $4,695*

The 6500/275 Video Editing System with 32MB RAM and 4GB hard disk costs $4,495*.

AppleShare goes Internet with IP 5.0

Designed as a complete server solution for small business or corporate users at the departmental and workgroup level, AppleShare IP 5.0 combines traditional file and print sharing with a full suite of Internet protocol services: mail, web serving and ftp. All use standard Internet protocols so files and services can be used by anyone with Internet access.

AppleShare IP 5.0 runs on any Power Macintosh with a PowerPC 601, 604 or 604e microprocessor; Mac OS 7.6 (included) or later; Open Transport 1.1.2 (included) or later; at least 32MB of RAM and 10MB of available hard disk space; and a CD-ROM drive.

It’s available in a variety of versions priced according to the number of clients. For five clients, it costs $955, 50 clients $1,695 and unlimited clients $2,695. For details of upgrades from previous versions of AppleShare, contact Claris upgrades on 1 800 028 316.

Indian Language Kit

Our latest language kit lets your Macintosh include Hindi, Sanskrit, Gujarati, Marathi, Punjabi and Nepalese text in your work.

Like our other language kits, it comes complete with appropriate fonts and is simply installed in the System folder. Once installed, you can easily move from language to language. Any WorldScript compatible application can take advantage of the language kits.

Contact Techflow on (02) 9971 4311 for prices and other details.

ColorSync starter kit

ColorSync, the heart of Apple’s colour management system, has proven itself as the only comprehensive way to control colour right through a computer-based production system.

Apple’s new ColorSync Starter Kit CD is aimed at anyone involved in producing commercial printed material, with advice, workflow suggestions and a range of press profiles to let you control colour from your scanner to your screen to your proof and right through to the press.

For more details and a copy of the full ColorSync white paper, visit the ColorSync website: http://www.colorsinc.apple.com. Or contact your Apple Masters of Media reseller.
**Director 6** brings even more power to this multimedia classic

Macromedia Director is synonymous with multimedia. Thousands of CD-ROMs, kiosks and multimedia presentations have been created using its powerful tools.

With the latest version, Director 6, its animation capabilities are greater, a lot of scripting is now automated and interface components are easier to get at. Animations and audio can now be synchronised.

**Netscape Communicator 4 hits the (virtual) streets**

Netscape Communicator is Netscape's new Internet application suite: Navigator to browse the Web, Messenger for e-mail, Collabra for text chats, Composer for Web page design, Conference videoconferencing, Calendar scheduling and administration and terminal emulation software. It's a handful! But although the full package takes up a lot of disk space, it can run in a reasonable amount of memory. According to Netscape, Navigator, Messenger, Collabra and Composer can all run in 6MB of memory simultaneously.

The new version of Navigator has what Netscape calls a 'smarter' user interface and powerful new technology that makes browsing dynamic web content easier than ever.


**Internet Explorer 4.0 is coming soon**

Microsoft's new release of Internet Explorer should be available in preview versions later this month. The new browser will support the powerful new capabilities of HTML 4.0, which was announced by the World Wide Web Consortium recently.

Visit Microsoft at http://www.microsoft.com for the latest news.

**Put live video on your web site**

Rearden Technology's SiteCam makes it simple to put video images on your web site. You can use this for remote monitoring or sharing video images with colleagues.

Visit Rearden's web site at http://www.rearden.com to find out more. And check out their live images of the San Francisco Bay Bridge.

**Another way to run Windows PC applications on your Macintosh**

Here's a new approach for those of us who have to use a PC application, but don't want to buy a Wintel box.

Virtual PC from Connectix (makers of Speed Doubler and RAM Doubler) could be the answer. Virtual PC lets you run PC applications on your Mac by emulating a PC based on a Pentium MMX. So you can install any Intel OS: Windows (95, 3.1 or NT), DOS, even OS/2 or OpenStep.

Virtual PC is distributed in Australia by Firmware Design. Call them on (07) 21 7211 for more information. The recommended retail price is $299.

**Easy font management**

DiamondSoft Font Reserve uses a database to manage printer fonts, screen fonts and font suitcases. You can find, preview and organise fonts in a variety of ways. It only runs on Power Macintosh at the moment. Download the demo from www.fontreserve.com.

**New games on the Mac**

Duke Nukem 3D from 3D Realms is a shoot-'em-before-they-shoot-you with some wild weapons and loads of style. http://www.3drealms.com

Quake, the sequel to Id Software's incredibly successful Doom will give you more things to shoot at. Weapons, enemies, environments are all ingenious and meticulously executed.

http://www.idsoftware.com

Developers excited by Apple's future plans

Apple's annual Worldwide Developers Conference (WWDC) is one of the big events on the Macintosh calendar. This year's focussed on the Internet, our forthcoming Rhapsody operating system and WebObjects, another major technology we acquired with NeXT. It also clarified our dual OS strategy (see page 3). Here's a quick rundown on these new technologies.

Rhapsody
Rhapsody is the code name for Apple's next generation operating system. It has four components: The Core OS, based on Mach technology; The 'Blue Box' Mac OS compatibility environment; the 'Yellow Box' development environment, based on NeXT's OpenStep; and an Advanced Macintosh User Interface. Apple expects Rhapsody to deliver industrial-strength performance, stability and new classes of software, while staying compatible with current hardware and software. Customers in markets like publishing, multimedia, Web authoring, corporate application development, higher education, engineering and scientific will quickly benefit from the advantages of Rhapsody.

There will also be a version of Rhapsody that runs the same Yellow Box applications on Intel-processor based personal computers and a development environment that runs under Windows.

All this news was well received by developers, who were excited at the prospect of being able to develop extremely powerful products for a range of different computing platforms.

WebObjects
WebObjects uses pre-built components and rapid application assembly tools to make it fast and simple to plug web sites into a company's data and applications. It's ideal for developing automated order entry, cataloguing, customer service, intranet services and more.

Yellow Box integrates Java and WebObjects
Presentations throughout WWDC made it clear how important Java is to Apple's next generation operating system plans. Java is going to be closely integrated to Rhapsody's Yellow Box along with WebObjects, providing an HTML interface to objects so it will be easy to create dynamic web-based applications. This will be very attractive to developers and large organisations because these applications can be used on Rhapsody for Mac and Intel, Windows NT, Solaris and HP-UX computers.

The timetable
Rhapsody is on-target for release to developers late this year. The first general release will be early in 1998. This will be aimed at high-end users who need the Yellow Box capabilities immediately and will have limited compatibility with the Mac OS.

Later in 1998, the 'unified' release will add the Mac OS compatible 'Blue Box' to Rhapsody providing compatibility with current Mac OS applications.

Read more about our dual OS strategy on page 3 of this issue.

Apple in Antarctica

On 21 June 1997, Australian National Antarctic Research Expeditions (ANARE) celebrated 50 years of the modern Australian Antarctic programme at a dinner in Hobart. Apple computers have been there since the early days of the Macintosh. In fact, in the late 80s, Macintosh became the standard personal computer for the organisation — at the request of the researchers and others who were using them. Macintosh computers also played a role in the recent ABC Antarctic special and book written by Tim Bowden.

So we were very pleased to be invited to be a part of the dinner celebrating Australia's 50 years of successful scientific endeavour in Antarctica.

To find out more about Australia's work in Antarctica, visit ANARE's web site: http://www.anare.gov.au.

Hack into a Mac Internet site? Not likely.

Keen to prove that Macintosh computers were a safe, secure solution for Web sites, a Swedish group set up a challenge. Anyone who could change a web page they'd put up on their Mac based web server (a Power Macintosh 8500/150 running WebSTAR with no special security hardware or software) would win a prize of A$18,000.

Over the three months the contest ran, over 100,000 people visited the site, with thousands trying their luck at breaking in using all kinds of techniques. Every attempt failed. The closest ones to succeeding were pure 'social engineering' (a wonderful computer security term which basically means using deception to try and get someone to give you a password or change a file).

Their second contest is now running.

For the full story (including the entertaining details of the social engineering attempts), visit the 'Hache' site at http://hache.infinet.se.

Newton subsidiary announced

Apple's Newton products division is becoming a separate company. With the very successful launch of the new eMate 300 and MessagePad 2000 this year, the time was right to spin Newton off as an independent entity.

The new company will continue to focus on computing and communications for mobile users, with an emphasis on providing solutions for health care, sales force automation and field service industries.

Don't miss the Interact Multimedia Festival

It's on again from Thursday 30 October to Sunday 2 November at the Melbourne Exhibition Centre.

Like last year's inaugural event, the focus is on the Internet, multimedia and new technology. Over the four days there'll be a wide range of events aimed at business, home, youth and music, centred on a major exhibition.

Apple will have a big stand right inside the exhibition entrance. We'll also be providing a giant Internet café together with the Festival and Access One. Come and visit! Thursday and Friday have a corporate focus, while Saturday and Sunday are aimed at home users.
Hot tips for some popular Macintosh applications

Claris Emailer 2.0: Saving addresses
After you’ve received an e-mail message, it’s easy to save the sender’s address. Just click on the + button next to the ‘From’ name. This opens a dialogue box so you can enter the sender’s details in your address book.

Claris FileMaker Pro 3.0: Linking databases
Rather than creating huge, all-embracing files in your database, try to split the data into separate files and use FileMaker’s relational power to bring information from the two (or more) files together. In an inventory database, for example, you should put the details of suppliers in one file, product details in another and so on.

PageMaker 6.5: Watermarks
Watermarks and other overlaid matter are easy to create using PageMaker 6.5. Using the layer’s floating window, add a new layer and put the watermark inside. If you’re using the watermark to show that your document is a draft version, don’t forget to turn the layer off before printing the final version.

ClarisWorks 4.0: Banners
It’s easy to create multipage banners and posters in ClarisWorks. Create a new drawing document and select the Format>Document… menu command. Edit the dialogue to specify the number of pages across and down, then zoom out to work on the whole spread at once. When you print, the pages will be laid out, ready to assemble into the finished banner.

ClarisWorks: Paint or draw
When opening a graphics file, make sure you correctly set the pop-up menu in the Open file dialog. If you want to use painting tools to alter individual dots on the screen, set the pop-up to Painting, otherwise make it Drawing.

Corel WordPerfect 3.5: Character spacing
You can control the spacing between adjacent characters easily and precisely with the Layout>Skip… command. The cursor between the two letters you want to kern, then select that menu command.

Microsoft Excel 5: Graphs
Before printing a graph, first check that the fonts used in the title, labels, and legend are high-quality outline fonts (PostScript or TrueType) and not the default ones. Not only will your pages look better, this avoids clipping, a common result of default fonts.

Microsoft Word 6: Bookmarks
When working with long documents, use bookmarks to make navigation easy. To place a bookmark, select the appropriate text and mark it by using the Edit>Bookmark command, then give it a self-explanatory name. You can jump to it later with the Edit>Go To… command.

System software: Keys
If you need a character that’s not on the keyboard, open Key Caps from the Apple menu. Hold down the Option, Control, and/or Shift keys to see all the choices.

Apple support just keeps getting stronger.

Improving the standard of support we offer our customers has been a priority here at Apple over the last eighteen months. Anyone who’s used any of our support services will have noticed a dramatic improvement.

More people, more phone lines, more resources, longer hours. All designed to help you get the most from your Apple computer.

While we will continue to provide our ‘up-and-running’ support free of charge for new users, we’re now offering a new service: Apple Assist Premium Support. While this does have a cost, we think it offers real value. Here’s what you get:

- Available 9am to 8pm Monday to Friday and 12 noon to 8pm Saturday
- A special priority 1-300 phone line (a local call charge from anywhere in the country)
- Your own password for quick service
- Later this year we’ll be adding a special section to Apple’s Web site

This costs just $99 per year, with unlimited access for a single user (corporate customers should ask about our larger support programmes).

Keep your software up to date
To make sure you’re always using the most up-to-date software on your Mac, get our Apple Software Upgrades CD. This includes the latest updates to all our system and utility software (though please note that they don’t include major ‘reference release’ versions of software like Mac OS 8, but they will include any updates to Mac OS 8).

The cost is just $30 plus $4.75 shipping. Or you can subscribe to the next five CDs for just $99 — a saving of over $40 on the individual price.

Special offers for AppleNews readers
Save on Premium Support: Sign up for Apple Assist Premium Support before 30 August and we’ll include the current software upgrades CD free — saving you $34.75.

Or save on Premium Support plus a full software upgrades subscription for $200. Saving $72.75 over the normal prices.

To sign up, or get more details of the Premium Support service, call us on 1 300 300 770.

Some Apple winners

▲ Filmmaker David Handley has a head start for next year’s Tropica Film Festival after winning a $10,000 Power Macintosh/Ad Media 100 digital video production system provided by Apple Computer and Animation Design.

▲ Tropfest has grown into a major annual event for the short filmmakers of Sydney.

Above left are Mark Richards of Animation Design (left), John Polson, director of Tropfest, (right) with a very happy David Handley in the middle (and of course his new video production system).

▲ Everyone who came to Apple’s ‘Easy Rider’ web seminars earlier this year was entered in a draw to win a Harley Davidson Sportster 1200 custom. Justin Van Mourik of South Australia was the lucky one, above (when’s he going to have time to work on web sites now?)

▲ Joanna Taylor from Presbyterian Ladies College at Croydon, NSW won our Twentieth Anniversary Macintosh competition.